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INTRODUCCIÓN 

 

GeneXus es una suite de desarrollo Low-Code que permite la generación rápida de aplicaciones de 

software en múltiples lenguajes y plataformas. GeneXus ofrece varias ventajas: es fácil de aprender, 

altamente productivo, multiplataforma y preparado para el futuro, de forma que protege sus 

activos digitales y simplifica la adopción de nuevas tecnologías. 

Por ejemplo, GeneXus genera aplicaciones para la Web y / o dispositivos móviles e inteligentes 

(desde un reloj pulsera, un celular, una tableta o una TV), para la plataforma de destino 

seleccionada por el desarrollador (cierto lenguaje, base de datos, entorno, plataforma, con diseño 

web responsivo, etcétera). 

Este documento es una guía para principiantes para desarrollar aplicaciones con GeneXus. 

 

COMENZAR A UTILIZAR GENEXUS 

Al abrir GeneXus, verás una interfaz similar a la siguiente que se conoce como IDE (Entorno de 

desarrollo integrado). Esta interfaz es fácil de usar y puede ser parametrizada por cada 

desarrollador.  

Se compone de diferentes ventanas: 
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1. Ventana principal (Página de inicio): muestra dinámicamente información técnica sobre la 

herramienta y la Comunidad GeneXus (noticias y soluciones publicadas por otros desarrolladores). 

También muestra los proyectos que se abrieron recientemente y ofrece la posibilidad de crear un 

nuevo proyecto. 

2. KB Explorer: muestra objetos y configuraciones del proyecto abierto actualmente. 

3. Barra de herramientas: muestra una interfaz fácil de usar para las funciones más utilizadas en 

GeneXus. 

4. Ventana de propiedades: muestra las propiedades asociadas con el contexto en el cual te 

encuentras posicionado (como un objeto seleccionado, atributo, variable, control, etcétera). 

5. Salida: muestra la salida de las acciones realizadas. 

  

CREAR UNA NUEVA APLICACIÓN CON GENEXUS 

 

Para comenzar a desarrollar una nueva aplicación con GeneXus, debes crear una nueva Base de 

Conocimiento (una Base de Conocimiento es un proyecto GeneXus). 

 

Al seleccionar File > New > Knowledge Base en la barra de herramientas, se mostrará el siguiente 

cuadro de diálogo: 

 

La aplicación que se definirá a lo largo de este documento es una aplicación real, pero simplificada 

para una farmacia. Por lo tanto, tiene sentido que la Base de Conocimiento se llame 
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"Farmacia" (o “Pharmacy” o “PharmacySystem”, entre otras opciones). A continuación, debes 

ingresar la ruta donde deseas crear esa Base de Conocimiento. 

 

También debes seleccionar uno de los lenguajes de programación disponibles en el combo 

Prototyping Environment. GeneXus utilizará el lenguaje seleccionado para generar la aplicación, así 

como los programas necesarios para crear y mantener la base de datos. El lenguaje seleccionado 

en este ejemplo es .NET Core. Más adelante, habrá que ingresar la información relativa a la base de 

datos. 

 

El combo Language te permite seleccionar el idioma en el que deseas que GeneXus genere los 

títulos de botones que se crean automáticamente, etiquetas, mensajes para los usuarios, etcétera. 

El idioma predeterminado es inglés. 

 

Al presionar el botón Create, GeneXus inicia el proceso de creación de la Base de Conocimiento. 

 

DEFINIR DE LOS PRIMEROS OBJETOS 

 

Una vez que hayas creado una nueva Base de Conocimiento, deberás describir las visiones de los 

usuarios. Para esto, es necesario identificar objetos de la vida real (recomendamos prestar 

atención a los sustantivos que los usuarios mencionan en sus descripciones, tales como: 

productos, facturas, clientes, etcétera) y comenzar a definirlos utilizando objetos GeneXus. 

 

Los desarrolladores GeneXus no trabajan en tareas de bajo nivel, como definir tablas, normalizar, 

diseñar programas, programación, y similares. En cambio, su trabajo es una actividad de alto nivel 

que implica describir la realidad de los usuarios. Después de eso, GeneXus analiza los objetos 

definidos y pasa a diseñar la base de datos y los programas de aplicación para la plataforma 

seleccionada de forma totalmente automática. 

 

Supón que la farmacia que solicita la aplicación desea poder registrar los Productos que tiene a la 

venta. 

 

Para describir cada objeto de la vida real identificado, debes crear un objeto GeneXus de tipo 

Transacción (no está relacionado con el concepto que se refiere a transacciones de la base de 

datos). Para crear un objeto Transacción, selecciona File > New > Object en la barra de 

herramientas. A continuación, se te mostrará el siguiente cuadro de diálogo que te permite 

seleccionar el tipo de objeto que deseas crear (en este caso: Transacción) e ingresar un nombre 

para él (en este caso: Product). 
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Al hacer clic en el botón Create, se crea la Transacción Product y se mantiene abierta para 

comenzar a definir su estructura: 

 

Cada Transacción tiene algunas secciones que se explicarán gradualmente. Concretamente, la 

estructura (Structure) de una Transacción permite definir los atributos o campos que describen un 

objeto de la vida real. 

Supón que en la farmacia te transmitieron que para cada producto necesitan registrar su código, 

nombre, precio de venta, stock y tipo (medicamento, cosmético, etcétera). Por lo tanto, estos datos 

que deben ser registrados para cada producto, coinciden con los atributos que deben crearse para 

esta Transacción. 
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Observa, en la imagen de arriba, que la primera línea en la estructura de la Transacción 

automáticamente queda lista para que definas el primer atributo. Además, observa que un ícono 

con la imagen de una llave está asociado con esta línea. Esto se debe a que, en cada Transacción, 

un atributo, o conjunto de atributos, debe configurarse con la función de identificador único o llave 

primaria. 

El concepto de identificador único o llave primaria tiene como objetivo identificar de forma única a 

cada producto (o cualquier objeto de la realidad). En otras palabras, los usuarios finales de la 

aplicación no podrán ingresar dos productos con el mismo valor identificador. Claramente, el 

atributo llave primaria de la Transacción Product es el código del producto. A continuación, se 

muestra cómo definirlo.  

Si presionas la tecla de punto en el teclado, GeneXus mostrará automáticamente el nombre de la 

Transacción como prefijo en el nombre del atributo: 

 

y solo te resta escribir Code después del prefijo Product: 
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Luego, al presionar la tecla Tab, puedes elegir el tipo de datos que se almacenará para este 

atributo. El tipo de datos predeterminado es: Numérico de 4 dígitos sin decimales. Sin embargo, la 

farmacia solicitó que el código del producto siempre debe tener un valor numérico de hasta 10 

dígitos, por lo que hay que cambiar su longitud a 10: 

 

 
 

Al presionar Enter, se abre una nueva línea donde puedes comenzar a definir el segundo atributo: 

 

Nuevamente, debes presionar la tecla de punto en el teclado y completar el nombre del atributo 

con Name, es decir, ProductName (del tipo Character y longitud de 50): 
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Ahora debes agregar el atributo ProductPrice (de tipo Numeric, con 9 dígitos y 2 decimales): 

 

Como probablemente necesitarás crear más atributos para definir precios o cantidades (es decir, 

cuando la farmacia compra o vende productos), podría ser una buena idea crear un tipo de 

definición genérica para todos los precios. Para hacer esto, en la columna Tipo, solo tienes que 

escribir: “Price =”, antes del tipo que tienes seleccionado: 

 

Luego presiona Enter, y verás que el atributo ProductPrice se ha establecido como de tipo Precio 

(Price): 

 

La definición de Precio con tipo numérico (9 dígitos con 2 decimales) se llama Dominio. 
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Los dominios permiten hacer definiciones genéricas. Una de las ventajas que proporcionan los 

dominios es que, si más adelante necesitas que los precios sean numéricos de una longitud 

diferente, solo deberás cambiar la definición del dominio para actualizar todos los atributos 

basados en ese dominio en un solo paso. 

 

Para ver los dominios creados en la Base de Conocimiento, seleccione View > Domains en la Barra 

de herramientas: 

 

 

Como puedes observar en la imagen, GeneXus crea algunos dominios automáticamente. Al hacer 

clic en un determinado dominio, la ventana de propiedades se actualiza mostrando las 

propiedades del dominio seleccionado. Ten en cuenta que, además de configurar el tipo de datos 

para un dominio, también puedes definir otras propiedades interesantes. 
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La ventana de Propiedades se actualizará cada vez que selecciones otro atributo, dominio, objeto, 

etcétera, con las correspondientes propiedades disponibles para su configuración en cada caso. Si 

no está visible, puedes presionar F4 para abrirlo. 

 

Regresa a la Transacción del Producto, donde el siguiente atributo que debes definir es 

ProductStock de tipo numérico, y longitud 4: 

 

Ahora es necesario registrar el tipo de producto. Podrías crear un atributo llamado ProductType 

como Character(50) … 

 

Pero, ¿qué pasa si los usuarios quieren ingresar dos productos del mismo tipo? Tendrían que 

ingresar el mismo nombre de tipo dos veces, ¡teniendo cuidado de escribirlo exactamente igual! 
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Más adelante, podrían necesitar buscar todos los productos de un cierto tipo y, para obtenerlos, el 

tipo debe haber sido escrito exactamente igual. 

 
 

Parece más razonable ingresar el tipo una sola vez, en un solo lugar, y de ahí en adelante para cada 

producto, asignar el tipo de producto correspondiente. Por lo tanto, hay que eliminar el atributo 

ProductType de la estructura y guardar la Transacción Product como se muestra: 

 

 

Para cada Transacción, GeneXus diseña automáticamente una interfaz Web (Web Layout) a partir 

de la estructura (Structure) definida. Esta interfaz Web permitirá a los usuarios de la aplicación, en 

tiempo de ejecución, agregar, actualizar y eliminar productos: 
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Ahora procede a crear otra Transacción para registrar los tipos de productos: 
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Para cada tipo de producto hay que registrar su código y nombre de tipo de producto, así que 

debes crear los dos atributos que se muestran: 

 

 

Recuerda la recomendación de presionar la tecla de punto en el teclado al definir atributos, 

para que GeneXus escriba automáticamente el nombre de la Transacción como prefijo, y solo 

haya que completar el final de los nombres de los atributos. 

 

Nombrar atributos con el nombre de Transacción como prefijo no solo permite definir atributos 

de manera más fácil y rápida, sino que también es una convención de la comunidad GeneXus 

para facilitar la comprensión al leer un nombre de atributo donde sea que esté, para saber a 

qué objeto se está describiendo. 

 

Observa las propiedades del atributo ProductTypeCode: 
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Observa la propiedad Autonumber. Está configurada con valor False por defecto, y al cambiarla a 

True, todos los nuevos tipos de productos ingresados por el usuario final se numerarán 

automáticamente en forma consecutiva. Por lo tanto, configura la propiedad Autonumber en True 

para este atributo identificador y guarda la Transacción ProductType. 

 

Como se explicó anteriormente, cada Transacción tiene una interfaz Web (Web Layout) diseñada 

automáticamente por GeneXus según su estructura. La siguiente imagen muestra la interfaz Web 

de ProductType: 
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Ahora, asigna un tipo de producto a cada producto. Para ello, vuelve a la Transacción Product, 

agrega una nueva línea en su estructura y escribe la letra "P". Se te mostrará la lista de atributos 

existente en la Base de Conocimiento que comienza con esa letra: 

 

 

Selecciona ProductTypeCode y se te mostrará la definición completa del atributo. 

 

En esta Transacción también debes incluir el atributo ProductTypeName, porque cuando los 

usuarios ejecuten esta Transacción y seleccionen un código de tipo de producto, querrán ver el 

correspondiente nombre del tipo de producto. Concéntrate en estos dos atributos que se 

encuentran incluidos en más de una Transacción: 
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ProductTypeCode es el atributo identificador en la Transacción ProductType (más específicamente, 

es la llave primaria de esa Transacción). Entonces, cuando se incluye una llave primaria en otra 

Transacción, GeneXus entiende que allí el atributo tiene el papel de llave foránea. 

 

Incluir un atributo que es una llave primaria de una Transacción en otra Transacción permite 

relacionar ambas Transacciones. 

 

GeneXus establece relaciones a través de nombres de atributos, por lo que cuando encuentra 

atributos con el mismo nombre en diferentes Transacciones, asume que se refieren al mismo 

concepto. 

 

El atributo ProductTypeName también está presente en ambas Transacciones. Sin embargo, no 

está marcado como identificador de ninguna de las Transacciones definidas. Por lo tanto, GeneXus 

entenderá que es un atributo secundario. GeneXus incluirá ProductTypeName en la tabla física 

ProductType que creará en la base de datos y no en la tabla física Product. 

 

 

El concepto de Transacción y el concepto de tabla física no son lo mismo. Recuerde que la 

Transacción es el objeto GeneXus que usted crea en la Base de Conocimiento para representar un 

objeto de la realidad. Al considerar su estructura y las demás estructuras de Transacciones 

definidas en la Base de Conocimiento (y también teniendo en cuenta algunas propiedades), 

GeneXus determinará las tablas físicas que debe crear en la base de datos, así como los atributos 

que debe almacenar en cada tabla. 

 

 

En tiempo de ejecución, cuando el usuario ejecute la interfaz Web de la Transacción Product, 

deberá ingresar para el atributo ProductTypeCode (que allí es un atributo llave foránea), un valor 

que haya sido previamente registrado a través de la Transacción ProductType. De lo contrario, se 
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mostrará un error. Al ingresar un ProductTypeCode válido, su valor ProductTypeName se obtendrá y 

se mostrará en la pantalla. 

 

GENERAR Y EJECUTAR LA APLICACIÓN POR P RIMERA VEZ 

Si deseas generar y ejecutar la aplicación por primera vez, solo tienes que presionar F5 y se te 

mostrará el siguiente cuadro de diálogo: 

 

 

GeneXus ofrece la posibilidad de crear un prototipo de la aplicación localmente o en la nube. Existe 

una propiedad para configurar su elección. De forma predeterminada, la propiedad está 

configurada para prototipar localmente. Entonces, debes ingresar el nombre que deseas para la 

base de datos de su aplicación y el nombre del servidor de base de datos que tienes instalado: 
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Al hacer clic en Finish, GeneXus evaluará el impacto causado por las nuevas definiciones en la Base 

de Conocimiento, y mostrará un informe de nombre Análisis de Impacto (Impact Analysis): 

 

Este informe muestra qué cambios estructurales deben realizarse en la base de datos. 

Observa que, en este caso, el título principal informa que se crearán las tablas de la base de datos 

(“The Database tables will be created”). 
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Al hacer clic en cada tabla (Product y ProductType en la ventana izquierda), verás, en la ventana de 

la derecha, los atributos que se incluirán en ellos:  
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Observa que, como se explicó, el atributo ProductTypeName no se incluye en la tabla física Product 

que se creará, a pesar de que la incluiste en la estructura de la Transacción Product (con el fin de 

mostrar su valor en la interfaz Web de la Transacción). 

 

Si estás de acuerdo con el Análisis de Impacto, puedes hacer clic en el botón Create, y GeneXus 

comenzará a crear los programas necesarios para crear la base de datos (aún inexistente), así como 

las tablas con sus estructuras en esa base de datos. Seguidamente, GeneXus ejecuta esos 

programas y después de crear la base de datos y las tablas, generará todas las líneas de código 

necesarias, en el lenguaje de programación seleccionado, para obtener la aplicación que permitirá 

a los usuarios insertar, actualizar y eliminar tipos de productos y productos. 
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A continuación, se te informará si el resultado fue exitoso o si hubo algún error o advertencia, y 

verás la aplicación ejecutándose: 

 

 

 

 

 

 

El navegador Web se abre por defecto, mostrando una página simple que ofrece una manera 

rápida de ejecutar los objetos definidos. 

 

Esta página simple, llamada Developer Menu (Menú del desarrollador), es para desarrolladores, 

como lo indica su nombre. Obviamente, no es lo que los usuarios verán. 

Haz clic, con el botón derecho del mouse, sobre el enlace ProductType y ábrelo en una nueva 

pestaña: 

 

La página que se muestra arriba permite al usuario agregar, actualizar y eliminar tipos de 

productos. Ingresa el primer tipo de producto. 
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Dado que el atributo ProductTypeCode tiene la propiedad Autonumber configurada en True, no 

será necesario ingresar un valor para el identificador porque se numerará automáticamente. Por lo 

tanto, ingresa el nombre del tipo de producto “Cosmetics”: 

 

 

Después de ingresar el nombre del tipo de producto y hacer clic en el botón Confirm, aparecerá un 

mensaje informando que los datos se agregaron correctamente. A continuación, la página quedará 

vacía y listo para ingresar otro tipo de producto: 
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Ingresa el segundo tipo de producto (por ejemplo “Medicines”): 

 

 

Haz clic en el botón Confirm. Puedes navegar y verificar los datos para confirmar que están 

numerados: 
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Ahora, ejecuta la Transacción Product. Para hacerlo, selecciona la pestaña del navegador donde se 

muestra la página del Developer Menu y luego ejecute la Transacción Product: 
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Agrega el primer producto: 

 

 Debes indicar el tipo de producto. Si recuerdas el código del tipo de producto, puedes ingresarlo. 

Otra opción es seleccionarlo de una lista haciendo clic en la flecha señalizada. 
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Ahora, intenta eliminar el tipo de producto “Medicines”: 

 

Un mensaje te informa que la eliminación no se puede realizar porque existen datos relacionados 

en Product (el medicamento para el dolor muscular STAR es un producto que pertenece a este tipo 

de producto). 
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LA APLICACIÓN CRECE 

 

Probablemente hayas notado todo lo que GeneXus generó automáticamente a partir de los dos 

objetos que definiste. 

 

Ahora supón que en la farmacia te dicen que, para cada producto, quieren registrar una imagen. 

 

Para hacerlo, vuelve a GeneXus y, en la Transacción Product, solo tienes que ingresar un atributo 

llamado ProductPhoto: 

 

El tipo Image te permite almacenar imágenes. 

 

La interfaz Web (Web Layout) se actualiza automáticamente, incluyendo el atributo ProductPhoto. 

 

Presiona F5 y GeneXus evaluará el impacto causado por las nuevas definiciones en la Base de 

Conocimiento. A continuación, se mostrará el Informe de Análisis de Impacto (Impact Analysis 

Report): 
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Recuerda que el Informe de Análisis de Impacto indica los cambios estructurales que se necesitan 

realizar en la base de datos. 

 

 

 

Al leer el informe, verás que el título principal, en este caso, informa que se necesita una 

reorganización de la base de datos. El término “Reorganizar” se refiere a la tarea de realizar 

cambios en la base de datos. En este caso en particular, el informe indica que la tabla Product debe 

actualizarse. 

 

Al hacer clic en el botón Reorganizar, GeneXus creará y ejecutará los programas que harán cambios 

en la base de datos. Luego, generará los programas requeridos que correspondan a la aplicación. 
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Observa que inmediatamente tendrás la aplicación ejecutándose nuevamente en el navegador 

web, con la nueva definición incluida: 
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Si recuerdas el código del producto, puedes ingresarlo. Otra opción es seleccionarlo de una lista 

haciendo clic en el botón SELECT. Desde allí, puedes recuperar el producto “STAR muscular pain 

medicine” y subir su foto: 
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AGREGAR REGLAS DE NEGOCIOS 

 

Además de todos los controles automáticos incluidos por GeneXus en las aplicaciones que genera, 

a veces quienes solicitan la aplicación piden realizar algunos controles específicos. En las 

Transacciones, las reglas que deben cumplirse, o los controles que se deben realizar, se definen en 

la sección Rules. 

 

Si, por ejemplo, un requisito es que no se permita guardar productos sin un nombre, GeneXus 

ofrece una regla llamada Error que te permitirá evitar eso: 

 

 

 

Presiona F5 y GeneXus guardará y evaluará las nuevas definiciones incluidas en la Base de 

Conocimiento. En este caso, deducirá que no es necesario modificar la base de datos, por lo que no 

mostrará un Informe de Análisis de Impacto. GeneXus generará el código necesario y luego 

ejecutará la aplicación actualizada con las nuevas definiciones. 

 

Ejecuta la Transacción Product. Ten en cuenta que, si el nombre del producto se deja en blanco, la 

regla que definió se ejecutará: 
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Hay otra regla cuya sintaxis es muy similar a la regla de error. Se llama Msg y la única diferencia 

entre ellas es que, si se cumple la condición, en este caso el mensaje se muestra como un aviso o 

advertencia, y el usuario puede seguir trabajando. 

 

Si, por ejemplo, deseas informar que el precio del producto se ha dejado en blanco sin obligar al 

usuario a que lo ingrese, puedes agregar la siguiente regla en la Transacción Product: 

 

 

 

Este conjunto de reglas podría escribirse en cualquier otro orden y el resultado en tiempo de 

ejecución sería exactamente igual, porque GeneXus analiza y determina cuándo debe dispararse 

cada una de las reglas definidas (cuando el usuario abandona cada campo, si la condición da 

verdadero, etcétera). 

 

Por supuesto, hay más reglas disponibles en GeneXus para definir diferentes tipos de validaciones y 

acciones. Cada Transacción debe tener sus propias reglas de comportamiento definidas. 
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DEFINIR CÁLCULOS: FÓRMULAS 

 

A menudo se necesita que las aplicaciones realicen cálculos que involucran los valores de ciertos 

atributos, constantes y/o funciones específicas. Para estos casos, GeneXus ofrece definir Fórmulas. 

 

Existen diferentes formas posibles de definir fórmulas. 

 

Empieza por aprender qué es una Global Formula. Una fórmula global es un cálculo que el 

desarrollador define asociado a un atributo. Observa que las estructuras de las Transacciones 

contienen una columna llamada Fórmula: 

  

 

 

Cuando se define un cálculo en esta columna para un atributo, significa que el atributo es virtual. 

En otras palabras, no se creará físicamente como un campo en una tabla porque el valor del 

atributo se obtendrá cada vez que sea necesario haciendo el cálculo. 

 

Ve esto con un ejemplo. Supón que la farmacia necesita saber, en todo momento, cuántos 

productos registrados hay de cada tipo de producto. Para ello, define un nuevo atributo en la 

Transacción ProductType con el fin de definirlo como una fórmula global: 
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Ahora, define el cálculo asociado al atributo ProductTypeProductQuantity. 

 

GeneXus ofrece una fórmula llamada Count para realizar la cuenta que necesita la farmacia (hay 

muchas otras, como Sum, Average, etcétera). 

 

El atributo que se incluye dentro del paréntesis de la fórmula le brinda a GeneXus la información de 

la tabla a navegar para hacer el cálculo (en la definición anterior, ProductName se encuentra 

dentro del paréntesis; por lo tanto GeneXus sabe que tiene que contar en la tabla Product).  

 

Luego, si GeneXus detecta una relación entre la tabla que navegará (Product) y el contexto donde 

está definido el atributo fórmula (ProductType), solo considerará los registros relacionados al 

realizar el cálculo. En este ejemplo, el atributo ProductTypeId está presente en ambos contextos: 

donde la fórmula se encuentra definida y en la tabla que debe navegarse para realizar el cálculo. 

Por lo tanto, para cada tipo de producto solamente se contarán los productos de dicho tipo de 

producto (en vez de contar todos los productos registrados en la tabla navegada). Si no se 

encuentra ninguna relación, GeneXus hará el cálculo considerando todos los registros de la tabla 

navegada. 

 

Presiona F5. Puedes ver que no se realizarán cambios físicos en la base de datos. GeneXus solo 

generará algunos programas y el Developer Menu se ejecutará nuevamente: 
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Ejecuta la Transacción ProductType para ver, para cada tipo de producto, cómo la cantidad de 

productos de dicho tipo siempre se calcula en el momento: 
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Puedes agregar más productos con el fin de verificar, para cada tipo de producto, que la cantidad 

de productos de dicho tipo siempre se calcula en el momento.  

 

 

USO DE PATRONES (PARA WEB Y PARA DISPOSITIVOS MÓVILES) 

 

Los patrones te permiten potenciar aún más tus aplicaciones, de forma automática. 

 

Aplicar un patrón es muy fácil, e inmediatamente GeneXus crea objetos, códigos y configuraciones 

para proporcionar comportamientos interesantes sin necesidad de programarlos. 

 

Observa la sección Patterns de una Transacción. Por ejemplo, en la Transacción ProductType, 

selecciona la sección Patterns: 
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Nota que hay dos pestañas disponibles, y cada una ofrece un patrón diferente para aplicarlo a la 

misma Transacción. 

 

En primer lugar, selecciona la pestaña Work With for Web. 

 

Para aplicar el patrón Work With for Web solamente tienes que hacer clic en la casilla Apply this 

pattern on save y guardar ( ): 

 

A continuación, si buscas la Transacción ProductType en el KB Explorer, puedes ver que hay varios 

objetos nuevos debajo de la Transacción: 
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Fueron creados por GeneXus por haber aplicado el patrón Work With for Web. 

 

Ahora presiona F5 para ver los resultados en tiempo de ejecución: 

 

 

Observa el último enlace que se muestra (WWProductType). Se te ofrece “trabajar con tipos de 

productos” (y desde allí hay invocaciones a la Transacción ProductType). Haz clic en ese enlace. 
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Puedes ver que se abre una página que muestra todos los tipos de productos almacenados. Esta 

página permite que los usuarios trabajen con los tipos de productos con una variedad más amplia 

de funcionalidades. 

 

Por ejemplo, haz clic en UPDATE para la primera línea: 
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Puedes ver que se abre la Transacción ProductType para editar los datos del tipo de producto que 

se encuentran en esa línea. Cambia el nombre del tipo y confirma: 
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Después de la edición y la confirmación, la aplicación vuelve a la página Work With Product Types 

(Trabajar con tipos de productos): 

 

 

El enlace DELETE ofrece eliminar el tipo de producto de la línea. 

 

Además, el botón INSERT ubicado fuera de la grilla, permite agregar nuevos tipos de productos.  

 

Al hacer clic en el botón INSERT, se abre la Transacción ProductType, lista para agregar un nuevo 

tipo de producto. Presiónalo para ingresar un nuevo tipo de producto (recuerda que en este caso 

solo es necesario ingresar el nombre del tipo de producto porque has configurado la propiedad 

Autonumber del atributo clave con valor True): 

 

 



  

43 

 

Una vez más, después de la inserción, la aplicación vuelve a la página Work With Product Types: 

 

 

Ahora observa que cada nombre de tipo de producto tiene un enlace. Haz clic en el enlace: 

“Medicines”. 

 

 

Se abre la siguiente página:  
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Como puedes observar, en la primera pestaña se muestran todos los detalles del tipo de producto 

seleccionado, y otra pestaña muestra la lista de productos que pertenecen a ese tipo de producto: 

 

 

La pestaña Product se generó automáticamente porque cada tipo de producto tiene varios 

productos relacionados. Si cada tipo de producto también tuviera varios datos relacionados de 

otro tipo, se habrían generado más pestañas para mostrar cada lista de datos relacionados con el 

tipo de producto. 

 

Ahora, vuelve a la página Work With Product Types, haciendo clic en el enlace correspondiente en la 

sección Recientes (Recents) que aparece en la parte superior izquierda de la página.  

 

Observa que es posible buscar por nombre. Esto significa que si, por ejemplo, el usuario escribe "C", 

solo se mostrarán los tipos de productos que comienzan con esta letra: 
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Vuelve a GeneXus. Hasta ahora, solo has seleccionado Apply this pattern on save en la pestaña 

Work With for Web de la Transacción ProductType, y después de guardar, has visto todas las 

funciones que se generan automáticamente. 

 

Lo que quizás no hayas notado es este árbol configurable: 
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Tiene nodos, subnodos y elementos configurables, de modo que es posible personalizar los 

comportamientos a generar (es decir, cambiar o agregar criterios de búsqueda, etcétera). 

 

Aplica también el patrón Work With for Web a la Transacción Product. Como se explicó antes, solo 

tienes que abrir la Transacción Product y en su sección Patterns, debes seleccionar la pestaña Work 

With for Web; entonces, tienes que marcar la opción Apply this pattern on save y guardar: 

 

 
 

Presiona F5. GeneXus genera los programas necesarios y ejecuta la aplicación con los cambios. 

Luego, ejecuta la página Work With Product: 

 

 

Puedes ver las mismas funciones de consulta que ya viste en la página Work With Product Types: 
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Inserta un nuevo producto: 

 

 

 

Después de la confirmación, la aplicación regresa a la página Work With Product: 
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Dado que es irrelevante mostrar el código de tipo de producto en la grilla, elimínalo del árbol 

configurable que se tiene en cuenta para generar este componente Work With for Web: 
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Presiona F5 y GeneXus guardará lo realizado, generando solo los programas necesarios y 

ejecutando la aplicación con los cambios: 

 

Agrega algunos productos de la misma manera consecutiva que se mostró anteriormente 

(presionando el botón INSERT que invoca la Transacción Product). 

 

A continuación, se muestra el cuadro de diálogo Work With Products que enumera todos los 

productos que se han agregado: 
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Ahora presta atención a la pestaña Work With for Smart Devices que se ofrece para cada 

Transacción. 

Aplícalo a la Transacción ProductType: 

 

 
 

Observa que bajo el nodo principal Level (ProductType), hay un nodo List. Si haces clic en él, en la 

ventana de la derecha verás una grilla que contiene el atributo ProductTypeName. 

 

A diferencia del patrón Work With for Web, en este caso, ya se muestra el diseño (Layout) con una 

grilla en vez de una lista de atributos debajo del nodo que se incluirán en la grilla. 

 

Ahora, observa el nodo Detail, que permite ver los detalles de una línea determinada de la grilla. 

 

El nodo Detail está compuesto por dos secciones: General y Product. 

 

Al igual que la funcionalidad implementada por el patrón Work With for Web, la sección General 

muestra los datos asociados con el tipo de producto seleccionado y la sección Product muestra 

dentro de una grilla todos los productos que pertenecen al tipo de producto. 
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Después de aplicar este patrón y guardar, si observas la Transacción ProductType en el KB Explorer, 

ahora puedes ver un nuevo objeto llamado WorkWithDevicesProductType debajo de la Transacción 

ProductType: 

 

Si observas los dos objetos generados en la Transacción ProductType, puedes ver que 

WorkWithDevicesProductType no tiene otros objetos debajo (porque incluye diferentes secciones 

para definir la implementación completa en su interior). 

En cambio, WorkWithProductType, como ya has visto, es una instancia configurable; y GeneXus 

genera otros objetos debajo de él para proporcionar los comportamientos útiles que se han 

mencionado. 

Pronto verás el componente WorkWithDevicesProductType en acción. 

La propuesta ahora es crear un objeto Panel, para que sea el primer objeto de la aplicación que se 

ejecute. El mismo mostrará una imagen, para que cuando el usuario la pulse, se ejecute el objeto 

WorkWithDevicesProductType. 

Como se explicó anteriormente, para crear un objeto solo tienes que seleccionar File > New > 

Object en la barra de herramientas: 
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Una vez que hayas creado el Panel (que en este ejemplo se le dio el nombre: PharmacyMenu), 

debes configurar su propiedad Main program = True, para que este objeto se convierta en un objeto 

ejecutable independiente del Developer Menu (es decir, es compilable y ejecutable por sí mismo). 
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Ahora inserta un control de imagen dentro de su sección Layout: 

 

Cuando seleccionas Insert > Image, se muestra la siguiente ventana. Si tu foto está almacenada en 

un archivo, debes presionar el botón Import from file (Importar desde archivo). 

 

 

Después de importar la imagen a la Base de Conocimiento e insertarla en el Layout del Panel 

PharmacyMenu, tu diseño debería tener este aspecto: 
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Al hacer doble clic en el control de imagen, se muestra su evento asociado por defecto: 

 

Dentro del evento Tap asociado a la imagen, se debe llamar al objeto 

WorkWithDevicesProductType; pero dicho objeto se compone de muchas partes (recuerda o mira 

nuevamente tus nodos). En este caso particular, se debe llamar al nodo Lista del objeto, ya que tu 

objetivo es mostrar la lista con todos los tipos de productos que ofrece la farmacia. 

 

Para llevar a cabo esto, después de ubicar el cursor dentro del evento, selecciona Insert > Object. 

 

Se muestra el siguiente diálogo: 
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Filtra como se muestra arriba y selecciona el objeto WorkWithDevicesProductType: 

 

 

 

El nombre del objeto se ha insertado, por lo que ahora debes completar qué componente del 

objeto debe ejecutarse. 

 

Para comprender lo que debes completar en la línea de código, revisa el árbol de nodos que está 

dentro del objeto WorkWithDevicesProductType: 
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El objeto tiene un nodo principal, ProductType, y debajo de él puedes encontrar los nodos List y 

Detail, respectivamente. Para llamar al nodo List, la sintaxis completa es: 

 

Ahora todo está definido y listo para ejecutar la aplicación para dispositivos móviles e inteligentes. 

 

Dado que el objeto PharmacyMenu tiene su propiedad Main Program configurada en True, puedes 

ejecutarlo independientemente del KB Explorer, haciendo clic con el botón derecho en el objeto y 

seleccionando Run: 
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Puedes ejecutar en tu computadora con un emulador de dispositivos móviles que se abrirá o 

directamente en tu dispositivo inteligente si lo conectaste a la computadora en la que estás 

trabajando: 

 

Cuando haces tap sobre la imagen, se muestra la lista de tipos de productos que ofrece la farmacia: 
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Ten en cuenta que el botón Insert en la esquina superior derecha se puede eliminar fácilmente, ya 

que esta aplicación es para usuarios finales, y no es la idea que puedan insertar nuevos productos; 

solo deben poder ver los diferentes tipos de productos, no editarlos. 

 

Al tocar cada tipo de producto (por ejemplo: "Cosméticos para adolescentes"), se muestra el 

Detalle, junto con sus dos secciones GENERAL y PRODUCT: 
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Obviamente, esto es solo una demostración muy simple ya que se pueden lograr aplicaciones 

mucho más sofisticadas. 
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¿QUÉ SUCEDE SI QUIERES GENERAR LO QUE HA S DEFINIDO HASTA AHORA EN OTRO LENGUAJE 

Y / O PARA OTRA BASE DE DATOS? 

 

Como se mencionó anteriormente, una de las grandes ventajas de GeneXus es que te permite 

generar la misma aplicación para diferentes plataformas, generar código en diferentes lenguajes de 

programación y/o almacenar los datos de la aplicación en diferentes bases de datos. Toda esta 

información se define en un Environment. 

 

Un Environment te permite configurar y almacenar toda la información relacionada con una 

determinada implementación de tu aplicación (los generadores que deseas utilizar para generar el 

Back-end de tu aplicación, los generadores que se utilizarán para generar el Front-end, la 

información de la base de datos, etcétera). 

 

Selecciona la ventana Preferences, haciendo clic en la pestaña que se encuentra al lado de la 

pestaña KB Explorer: 

 

 

Puedes observar que hay un único Environment definido (.NET Core Environment). Se creó 

automáticamente al momento de crear la Base de Conocimiento cuando elegiste .NET Core como 

lenguaje de generación.  Luego, se completó con más información cuando presionaste F5 por 

primera vez e indicaste la información relativa a la base de datos a crear y el servidor de base datos. 

Los subnodos del Environment permiten configurar más propiedades. 
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Es posible crear más de un Environment para la misma Base de Conocimiento. Por ejemplo, es 

común crear un Environment para desarrollo donde se conecta a una base de datos con datos de 

prueba y otro Environment para producción, donde se define el servidor y la base de datos que 

usará para el sistema terminado. 

 

También es posible que desees crear, en la misma Base de Conocimiento, un nuevo Environment 

para generar todo para una plataforma diferente (por ejemplo, generar el código en Java y utilizar 

otro DBMS como podría ser Oracle, MySQL, PostgreSQL, DB2 u otros. Y para la generación del Front 

end podrías usar Apple o Angular).  

 

Como se muestra en la siguiente imagen, para crear un nuevo Environment, debes hacer clic con el 

botón derecho del mouse sobre el nodo de su Environment, seleccionar New Environment y luego 

configurar las propiedades necesarias. 

 

Para elegir trabajar con un Environment u otro, debes hacer clic con el botón derecho sobre el 

Environment que desees activar y elegir Set as current (Establecer como actual).  

 

Puedes identificar fácilmente el Environment activo por el símbolo PLAY. 

 

Obtenga más información sobre cómo crear un nuevo entorno. 

  

https://wiki.genexus.com/commwiki/servlet/wiki?24702,Create+new+environment+dialog,
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¿QUÉ MÁS OFRECE GENEXUS? 

 

- Acceso a bases de datos externas: 

o Es posible que necesites acceder a bases de datos externas desde aplicaciones GeneXus. 

Por ejemplo, cargar datos de una base de datos externa a las tablas de la base de datos 

asociada con la Base de Conocimiento para realizar una carga inicial. A continuación, tal 

vez no necesites permanecer conectado a esa base de datos externa, o puede que necesites 

conectarte y estar siempre conectado a una determinada tabla o tablas de una o más bases 

de datos externas (no solo para leerlas, sino también para acceder y cambiar los datos en 

ellos). GeneXus ofrece un “proceso de ingeniería inversa” para conectarse a tablas de bases 

de datos externas con el fin de lograr las necesidades descritas anteriormente. 

 

- Soporte de desarrollo colaborativo:  

o GeneXus Server ofrece la opción de cargar una Base de Conocimiento en un servidor. A 

continuación, los nuevos desarrolladores pueden crear una copia local desde la Base de 

Conocimiento en el servidor, desde cualquier lugar geográfico, cuando surja la necesidad. 

Pueden trabajar (siempre localmente) y enviar sus cambios al servidor. Por supuesto, existe 

un mecanismo para la resolución de conflictos. Esta solución ofrece muchas ventajas, 

incluido el control de versiones de los modelos en la Base de Conocimiento. 

 

- Consumir y definir servicios web: 

o Es posible consumir servicios web desarrollados por terceros desde una aplicación 

GeneXus, así como desarrollar sus propios servicios web con GeneXus. 

 

- Definir actualizaciones masivas de la base de datos y definir libremente otros tipos de procesos. 

 

- Definir paneles interactivos y personalizados para aplicaciones web y aplicaciones para 

dispositivos móviles. 

 

- Diseñar y ajustar interfaces de usuario (UIs) 

o GeneXus ofrece potencia para personalizar la interfaz de usuario y, debido a que la 

experiencia del usuario es extremadamente importante, ofrece generadores específicos 

para aplicaciones nativas, aplicaciones con diseño web responsivo, web móvil, etcétera. 

También ofrece una función Live Editing de edición en vivo multiplataforma que simplifica 

el proceso de diseñar su aplicación y crear un prototipo en vivo (Live Prototyping). 

 

 

 

http://wiki.genexus.com/commwiki/servlet/wiki?27805,Toc%3ALive+Editing
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- Implementar tu aplicación en producción en servidores locales o proveedores de servicios en la 

nube 

o Al hacer clic en un botón puedes implementar tu aplicación en producción. 

 

- Documentar dentro de la Base de Conocimiento 

o GeneXus proporciona un editor de Documentación de estilo Wiki, para que puedas describir 

fácilmente el propósito de la Base de Conocimiento (en un objeto del tipo de 

Documentación, llamado Main, que se crea automáticamente en toda Base de 

Conocimiento). 

 

Además, todos los objetos GeneXus tienen una pestaña de Documentación, donde también 

puedes describir el propósito del objeto. 

 

Al escribir la documentación, puedes incluir textos, imágenes, enlaces a atributos, objetos, 

etcétera. Los archivos también se pueden almacenar en la Base de Conocimiento como 

parte de su documentación. 

 

- Inteligencia artificial 

o GeneXus proporciona capacidades para integrar fácilmente la Inteligencia Articial (IA). 

 

- Generador de chatbot 

o GeneXus incluye un generador de Chatbot para crear e implementar automáticamente un 

chatbot en cualquiera de los proveedores de Chatbot compatibles. 

 

- Extensibilidad 

o GeneXus permite crear extensiones específicas, que te permiten aprovechar diferentes 

lenguajes de plataforma para crear soluciones específicas y ampliar las capacidades 

centrales de GeneXus. 

 

- Integración de sistemas externos y fuentes de datos en una aplicación GeneXus. 

o GeneXus ERP Connector para SAP hace posible el desarrollo de aplicaciones integradas a 

SAP ERP, lo que le permite complementar las funcionalidades que ofrece. 

 

- Gestionar la seguridad 

GeneXus ofrece un módulo de seguridad (totalmente integrado en GeneXus), llamado 

GeneXus Access Manager (GAM). Con solo habilitarlo, ofrece resolver las funcionalidades de 

autenticación y autorización, tanto para aplicaciones web como para dispositivos móviles y 

dispositivos inteligentes. 

 

https://wiki.genexus.com/commwiki/servlet/wiki?40167,Toc%3AGeneXus+Artificial+Intelligence,
https://wiki.genexus.com/commwiki/servlet/wiki?37102,Chatbot+generator,
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- Modelar y automatizar procesos de negocios 

o GeneXus cuenta con un conjunto de herramientas que permiten el modelado y la 

automatización de los procesos de negocios, así como un entorno de ejecución para 

administrarlos. La herramienta de modelado GeneXus Business Process Modeler se basa en 

el estándar BPMN 2.0 y está dirigida a usuarios cuyo objetivo es modelar procesos de 

negocios. Estos diagramas se pueden integrar o crear en el entorno de desarrollo de 

GeneXus para implementar la etapa de automatización, donde, mediante GeneXus, 

asociamos los diferentes objetos en cada tarea modelada en los procesos. GXflow ofrece las 

herramientas de ejecución, administración y monitoreo para los usuarios finales. De esta 

manera, GeneXus ofrece lo que conocemos como GeneXus BPM Suite, que es el conjunto de 

herramientas que permiten el desarrollo de sistemas basados en Business Process 

Management, es decir, sistemas orientados a procesos de negocio. 

 

- Informes 

o Definición de informes estáticos (informes típicos que pueden imprimirse, guardarse o 

visualizarse en la pantalla). 

o Definición de consultas visuales y dinámicas. 

▪ Puedes crear consultas a la base de datos, agrupar datos según uno o varios 

criterios, realizar cálculos y, finalmente, mostrar el resultado en diferentes tipos de 

gráficos, tablas de pivote y tablas. Para llevar a cabo este tipo de consultas, 

GeneXus ofrece el objeto Query y el control Query Viewer. 

▪ Además, el producto GXquery permite a los usuarios finales realizar consultas de 

forma dinámica, basándose en el mismo modelo de datos de la Base de 

conocimiento. Esta herramienta se enfoca en habilitar el acceso y análisis de datos 

en la base de datos operativa real del sistema, y le brinda al usuario una interfaz 

intuitiva desde la cual puede crear sus propias consultas y luego verlas a través de 

la interfaz web y la aplicación móvil, o integradas en Microsoft Office Excel. 

 

- Desarrollo compartido y Marketplace 

o GeneXus Marketplace te permite compartir tus controles de usuario, extensiones, patrones, 

herramientas externas y objetos externos creados para y con GeneXus. 

 

- Test de aplicaciones con GXtest 

o Cuando se implementan nuevas funcionalidades o variaciones, es necesario verificar que lo 

que ya funcionó (antes de los cambios) continúe funcionando correctamente. Este tipo de 

tarea puede volverse muy tediosa si la aplicación crece mucho, ya que la cantidad de cosas 

a probar aumentará cada vez, etcétera. GeneXus ayuda a automatizar estas pruebas a 

través de su software GXtest, que te permite guardar secuencias de operaciones para 

https://marketplace.genexus.com/home.aspx?,en
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probar. Luego, las pruebas se reproducen automáticamente, verificando que el sistema aún 

funciona correctamente. 

PRÓXIMOS PASOS 

Has llegado hasta aquí familiarizándote con GeneXus, por lo que la pregunta natural es “¿Cuál es el 

próximo paso?”. 

 

- Primero lo primero: 

o Accede al siguiente curso en línea para continuar aprendiendo: 

https://training.genexus.com/es/aprendiendo/cursos/genexus/v17/core 

o Si aún no has probado GeneXus, puedes hacerlo gratis en este link: http://genexus.com/trial 

 

-  Aprende más: GeneXus es una plataforma de desarrollo muy completa, y hay mucho que leer 

y aprender. Podrías comenzar a profundizar en:  

o Sitio de Capacitación de GeneXus: http://training.genexus.com/ 

o GeneXus Wiki: http://wiki.genexus.com/ 

 

¡Obtiene GeneXus! Nos esforzamos para proporcionar la mejor herramienta con el fin de simplificar 

el desarrollo de software, por lo que recibimos a cada nuevo cliente como el primero. Ponte en 

contacto con nosotros a través de info@genexus.com o visita http://genexus.com/plans para ver 

cuál te conviene más. 

 

- Sé parte de nuestra comunidad: cuando estés listo, puedes unirte a nuestra comunidad en 

constante crecimiento a través de una gran variedad de opciones. 

o Publica tu trabajo en nuestro Marketplace: http://marketplace.genexus.com/  

o Trabaja con GeneXus: http://genexus.com/company/work-with-us?en 

o Oportunidades ofrecidas por nuestros socios: 

http://genexus.com/jobs/Opportunities?en  

o Sé parte de la GeneXus Alliance: http://genexus.com/partners  

o Asiste al próximo Encuentro GeneXus:: http://genexus.com/meetings  

 

 

We really hope we hear from you soon!! 

  

https://training.genexus.com/es/aprendiendo/cursos/genexus/v17/core
http://genexus.com/trial
http://training.genexus.com/
http://wiki.genexus.com/
http://marketplace.genexus.com/
http://genexus.com/company/work-with-us?en
http://genexus.com/jobs/Opportunities?en
http://genexus.com/partners
http://genexus.com/meetings
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